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Welcome!
You’re about to embark on 

a journey that goes beyond just using 
technology—you’ll learn how it really works 
and how you can shape the future with it. 

From coding challenges to real-world 
applications, this course will help you sharpen 

your skills and spark new ideas. 
Let’s level up together!
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An innovative approach to building digital competencies, developed by 
expert educators.

Curriculum aligns with the latest industry standards, preparing students for 
certifi cations and future careers.

Well-defi ned learning goals and hands-on, applicable digital skills.

Key Features

Each unit offers 
straightforward explanations 

and contemporary 
examples, making 

technology concepts 
accessible and relevant.

Every unit includes a variety of 
tasks and activities designed 

to help students build 
essential digital competencies.

Students learn about platform 
diversity, expanding their 

digital toolkit and adaptability.

Projects and exercises 
throughout the course reinforce 

students’ understanding and 
practical application of digital 
skills in real-world scenarios.

Each unit organizes key terms 
that are crucial for digital 

literacy, equipping students 
for today’s technology-driven 

workplace.
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1.  Handling 
databases

Managing structured data ensures information is 
organized and accessible for decision-making and 
problem-solving. This unit covers organizing data using 
tables in a database, creating forms and reports for 
inputting and sharing data, and extracting specific 
information to gain valuable insights.

Learning Objectives
In this unit, you will:
> describe structured data, its importance, and how to manage it 

effectively in database management systems.
> create a database by defining tables and fields in a database 

management tool.
> input, organize, and manage different data types in a table using 

appropriate data types, field properties, and sorting functions.
> troubleshoot common database issues by identifying and 

resolving errors related to data input, queries, and forms.
> create and customize a data entry form using a form creation 

tool, including steps to insert, edit, delete records, adjust layouts, 
and attach labels to fields.

> create and run queries using a query design tool, by adding 
tables, selecting fields, applying filters, and designing parameter 
queries.

> design and save custom reports using a report creation tool,  
including grouping data, sorting fields, and adding calculations 
like totals and averages.

> export data from a database system to spreadsheet or CSV file 
formats using export functions.

> import data from spreadsheet or CSV file formats into a database 
system using an import tool.

Tools
> Microsoft Access
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Grocery list

LESSON 1

Structured information

Do you make a list before you go grocery shopping? A grocery list is an example of structured 
information. The term "structured" means organized and arranged in a specific way. In particular, 
a simple list is usually divided into rows and columns. In this example, the grocery list could be 
structured like a table, where each row represents a product and the following columns contain its 
details:

1. Product name

2. Quantity

3. Estimated price (to help you estimate the total cost of all the products)

Product name Quantity Est. price

Apples 5 $5.5

Yogurt 3 $3

Bags of rice 2 $2.5

Bottles of milk 4 $3.5

Bottle of orange juice 1 $2.5

Shampoo 1 $6

Cereal 1 $4

Total $27

Structured information always consists 
of rows (records) and columns (fields), 
like a table. Each column has its own 

title that defines the column data.

What is a database? 
How do database tables simplify the process 
of comparing and analyzing information?

This list is an 
information table.
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Databases and structured information 
Α database stores and organizes structured information, such as data arranged in rows and columns 
within tables. For example, in a student management system, the database could include tables for 
storing student details, course information, and grades. Building such a database is essential to 
ensure that the data is well-organized, readily accessible, and reliable.

The following diagram details the stages of building a student management system database:

1  Identifying requirements

 • Collect students' data and their grades.

 • Find out who will use it and benefit 
from it.

2  Analyzing requirements

 • Determine the valuable data.

 • Specify the users' permissions.

4  Create the database

 • Build the database using one of a 
database management tool, such as 
Microsoft Access.

3  Designing the database

Create a diagram detailing:

 • The database tables and their fields. 

 • How the tables are linked.

6  Maintain the database

 • Update the content.

 • Redesign if needed.

5  Test the database

 • Test and modify the database 
according to the requirements.
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Create a database
In this unit, you will focus on setting up a database. You will create and develop a student 
management system database using Microsoft Access.

To create your database:

> Open Microsoft Access.
> From the available templates, click Blank database. 1

> In the pop-up window, type a file name for your new 
database in the File Name field. 2  Your database file will be 
saved to the location indicated below the File Name field. 3

> Click Create. 4

1

Optionally, click the Browse button next to the File Name box 
and browse to a different location in which to save the database.

2

4

3

9For Review Purposes Only 



1.
 H

an
d

li
n

g
 d

at
ab

as
es

Creating a table
Now that your new database has been created, continue by creating a table of structured 
information in your database.

When a blank database is created, Microsoft Access goes to Datasheet View and creates a blank 
table named "Table1." In Datasheet View, you can immediately enter data in your table and let the 
program build the table structure automatically.

In this lesson, you are going to use Design View instead. In Design View, you decide how you want 
your table to be structured. Then you either switch to Datasheet View to enter data, or you enter 
your data by using some other method, such as a form. You will learn about forms in the next activity.

While field 
descriptions are not 
mandatory, including 
them in large tables 
with multiple fields 
can improve clarity.

To create a table in Design View:

> On the Home tab, in the Views group, 
click on the drop-down arrow and select 
Design View. 1

> In the Save As window, in the Table Name
field, type the name of your table, e.g., 
"Student Grades", 2  and click OK. 3

> In the Field Name column, type a name for 
each field in your table, 4  and in the Data 
Type list, click a data type. 5

> Let’s name our first field "StudentID" and 
leave the Data Type as AutoNumber. 

> Type the rest of the field names as they 
are in the screenshot and assign the 
appropriate data types. 6

> Press  +  to save your table.

1

4 5

6

3
2

In the Description column, you can enter 
additional information for each field.
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Field properties
In Design View, when you click any of your fields’ characteristics (Field Name, Data Type, or
Description), you can check and edit several of that field’s properties in the Field Properties pane 
at the bottom of the window. In addition, on the Table Design tab, you can click Primary Key 1  to 
make the selected field the primary key. You will next learn about the concept of primary keys and 
their essential role in database design and integrity.

1

Data types and their uses

Data Type Purpose

Short Text For up to 255 characters of text.

Long Text A block of text that is more than 255 characters long and that may also 
contain formatted text.

Number A numeric value that can be used in calculations.

Large Number Use this data type to efficiently calculate large numbers.

Date/Time For date or time data.

Currency For numeric values that refer to money and always include decimals.

AutoNumber Use an AutoNumber field to provide a unique value that serves to make each 
record unique. The most common use for an AutoNumber field is that of a 
primary key.

Yes/No For Boolean values like Yes/No, True/False, On/Off, 1/0.

OLE Object For attaching an OLE Object, such as a Microsoft Excel workbook, to a record.

Hyperlink For an email address or a website URL.

Attachment For attaching files or images to a record. For example, you can use an 
attachment field to attach a photo of each of the students.
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Simplifying database structure
The structure of a database table can be simplified by separating this table into smaller related 
tables. This is helpful for keeping the data organized and manageable. For example, by separating 
student details, course information, and grades into separate tables, we can avoid repeating 
personal information for every course a student takes.

So, let's divide the "Student Grades" table into three separate tables, as we describe below.

Students
StudentID, Name, Address, City, Postal Code, Telephone number, Class No

Courses
CourseID, Course Name, Class, Teacher

Grades
StudentID, CourseID, 1st Semester Grade, 2nd Semester Grade, Final Grade

Field properties overview

Property Use

Field Size The maximum size of your field’s data. For example, Short Text fields can 
range from 1 to 255 characters. It’s recommended to use the smallest field 
size sufficient for the data to ensure better performance. Some data types 
have a fixed field size, for example, date/time or currency.

Input Mask This displays editing characters to guide data entry. For example, an input 
mask for a field with an amount of money might display the dollar currency 
symbol ($) at the beginning of the field and allow only numbers to be 
typed.

Caption This is the label text that is displayed by default for this field in forms, 
reports, and queries. If this property is empty, the name of the field is used. 
An effective caption is usually brief.

Default Value The specified value is automatically assigned to the field when a new 
record is added.

Validation Rule An expression that must be true whenever you add or change the value in 
this field.

Validation Text A message that is displayed when a value that is entered violates the 
validation rule.

Required This property requires that data must be entered in the field. Use this for 
fields that are required, such as Name.

Allow Zero 
Length

This allows entry (by setting it to Yes) of a zero-length string ("") in a 
Hyperlink, Short Text, or Long Text field.

Indexed This specifies whether the field has an index. Use indexes on fields that are 
frequently used to make the operations involving that field faster.
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Let’s make these changes to our database and then relate the tables to each other.

To rename a table:

> Click the Close button, 1  to close the Student Grades table.
> In the Navigation pane, right-click the Student Grades table, 2

and click Rename. 3

> Type "Students" and press . 4

1

Did you notice the small key next 
to the StudentID field name? The 
key tells you that the StudentID  

field is the primary key. The 
primary key is unique and cannot 

be the same in two records.

4

Smart Tip
Give a relevant name to each field so that you can tell what it contains without having to check 
the data.

2

3
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To set up a new table structure:

> On the Create tab, in the Tables group, click Table Design. 1

> Type the field names given in the screenshot with the appropriate 
data types. 2  Make sure to set the CourseID field as the Primary Key. 3

> Click the Save button. 4  This will be the Courses table. The program will ask you 
to name your table. Type "Courses" and click OK. 5

4

1

3

2

5
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To modify an existing table structure:

> In the Navigation pane, right-click the Students table, 1  and click Design View. 2

> Select all the extra fields that are not needed in this table, 3  and press .
> Click the Save button. 4

> Now create the Grades table on your own and type the appropriate fields. 
No Primary Key is required here. 5

3

4

1

2

5
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Keys and relationships
Each record must be unique to ensure accurate data management when working with databases. 
For example, each person is unique. Even when two people have the same name, they have 
different emails or telephone numbers. In a database about people, such as friends, each record 
needs to describe a unique person.

Primary key
A primary key consists of one or more fields that can uniquely identify each record in your database 
table. For example, if you know that there cannot be two people with the same email address in your 
friends database, you can use the Email Address field as the primary key. Similarly, if you are sure 
that the combination of name and email address is unique for your friends, then the Name and Email 
Address fields can be the primary keys. 

StudentID Name Telephone Number Email Address

1 Tom 212 500 202 tom.bacademy@outlook.com

2 Tom 212 500 202 tomas.bacademy@outlook.com

The ID field
Sometimes, you cannot find a good primary key even if you include all 
the fields. Occasionally, you may need to include so many fields in your 
primary key to make it unique that it becomes too large, taking up too 
much space. So, what do you do in such cases? You can create a new 
one if you cannot find a primary key in your existing fields. We usually refer to that as the ID field. ID 
comes from the word "identity," a very fitting name since this field identifies each record. For 
example, StudentID in the "Students" table is a primary key because it uniquely identifies each 
student.

Table relationships
In databases, relationships are connections between tables that allow you to combine data from 
different tables to extract useful information. Databases have the following relationship types 
between tables:

1. One-to-One: Each record links to only one record in another table. For example, a table of 
student profiles could be linked one-to-one with a table of student login credentials.

Students

The simplest way to 
create a one-to-one 

relationship is to split an 
existing table in a 

database into two tables 
and link them using the 

same primary key.

Why primary keys 
matter:

If no field is unique, you 
create an ID field (e.g., 

1, 2, 3…) to identify 
records efficiently.

They keep records 
unique and avoid 

duplicates.

They save space and 
make databases work 

faster.

This is the primary 
key symbol.
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2. One-to-Many: One record links to many records. For example, one student can have grades for 
multiple courses.

3. Many-to-Many: Records in both tables link to multiple records. For example, a student can take 
many courses, and a course can have many students enrolled.

1

To create relationships between tables:

> On the Database Tools tab, in the Relationships group, click Relationships. 1

> In the Add Tables pane, select all the tables, 2  click Add Selected Tables, 3  and then click 
the Close button at the top corner of the pane. 4

> Drag the StudentID field from the Students table and drop it on the StudentID field of the 
Grades table. 5

> In the Edit Relationships window, click Create to establish the relationship. 6

> In the same way, drag the CourseID field from the Courses table and drop it on the CourseID
field of the Grades table. 7

> Click Close. 8  If prompted, save your changes. Your tables are now successfully related.
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3

2

4

6

8

7
5

Enforce Referential Integrity prevents "orphan" 
records and keeps references synchronized so that 

you won’t have any records that reference other 
records that no longer exist.

Cascade Delete Related Records deletes all the 
related records, if a record is deleted. This way, you 
avoid orphan records in your tables and records not 

connected to anything else in your database. 

Cascade Update Related Fields updates all the 
related records if a primary key changes in a table.

To relate two fields, they must be 
compatible data types. The most common 
case is to relate an AutoNumber field with 
a Number field, since they are compatible.

Hands on!
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1. Read the following sentences and put a check mark for True or False.

True False

1.  Structured information is always displayed in rows and columns.

2.  In Microsoft Access, a table created in "Datasheet View" allows 
you to immediately enter data.

3.  In "Design View," the table structure is automatically built by the 
program.

4.  The "Primary Key" ensures that every record in a table is unique.

5.  The "Data Type Currency" can include decimals for numeric 
values.

2. Read the questions and put a check mark for the correct answer.

1.  Which of the following is the first step to create a blank database in Microsoft Access?

 a. Click on "Create Table" under "Table Tools."

 b. Open Microsoft Access and choose "Blank Database."

 c. Select an existing template for tables.

 d. Enter data directly in "Datasheet View."

2.  What is the purpose of an "AutoNumber" data type?

 a. To allow numeric values used for calculations

 b. To attach files or images to a record

 c. To provide a unique value for each record automatically

 d. To store "Yes/No" values for a record

19

Hands on!
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3. Match the data types and their uses.

 For a file or image

 For numeric values including money

 For up to 255 characters of text

 To create a unique record ID

 For Boolean values like True/False

1.

2.

3.

4.

Short Text

AutoNumber

Currency

Attachment

Yes/No5.

3. In the "Field Name" column of a table, what is "StudentID" typically used for?

 a. To identify each student uniquely in the table

 b. To record the student's grade for a semester

 c. To list the student's telephone number

 d. To describe the table structure

4.  Which property specifies whether a field is optimized for faster searching and sorting 
within a database?

 a. Input Mask

 b. Indexed

 c. Validation Rule

 d. Default Value
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4. Complete with the missing word.

1. In Microsoft Access, structured information is typically arranged in rows, called 

 , and columns, called .

2. The "Field Properties" pane allows users to edit a field's size, data type, and 

  for additional details. 

3.  The most common use of the "AutoNumber" field is to set a  

for each record, ensuring uniqueness.

4.  "Table Relationships" can combine data from multiple tables. The most common type of 

relationship is , where one record links to many records.

5.  The "Primary Key" is important because it prevents  and 

ensures every record is unique.

5. You have to create a library inventory database to manage information about authors and 
the books they have written. 

1.  Open Microsoft Access and create a blank database. Name the database 
"LibraryInventory."

2. Create a new table to store authors' details including the following fields:

 • AuthorID (AutoNumber, Primary Key)

 • Author Name (Short Text)

3. Save the table as "Authors."

4. Create a new table to store book details including the following fields:

 • BookID (AutoNumber, Primary Key)

 • Title (Short Text)

 • AuthorID (Number)
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 • Author (Short Text)

 • Genre (Short Text)

 • Year Published (Number)

5. Save the table as "Books."

6. Enter the following records in Datasheet View:

 • Authors Table:

> Record 1: AuthorID: Auto-generated, Author Name: Antoine de Saint-Exupéry

> Record 2: AuthorID: Auto-generated, Author Name: Roald Dahl

 • Books Table:

> Record 1: BookID: Auto-generated, Title: The Little Prince, AuthorID: 1, 
Genre: Fiction, Year Published: 1943.

> Record 2: BookID: Auto-generated, Title: Charlie and the Chocolate Factory, 
AuthorID: 2, Genre: Fiction, Year Published: 1964.

7. Create relationships between "Books" and "Authors" tables. 

8. What type of relationship exists between tables? 

9. Save and close the database.
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LESSON 2

Data entry forms

Now that tables have been created in the database, a data entry form can be created. This form 
helps add information or edit existing data. Data can always be added from the tables. Forms serve 
as the interface created for users, providing a simple way to enter data without directly editing the 
tables or understanding how the database is structured.

Forms also allow control over which data the user can access, ensuring that only specific fields or 
records in the database can be checked or edited.

For this activity, you will work on the "Students" table that you created in the previous lesson.

To create a form using the Form Wizard:

> Make sure all database objects are closed, and  select the Students table, 1  from the 
Navigation pane. 

> On the Create tab, in the Forms group, click Form Wizard. 2

> In the Form Wizard window, click the  button, 3  to include all the fields in the form.
> The StudentID field is excluded from the form, as it contains no relevant data for the 

user and is updated automatically. To remove it, click it in the Selected Fields list, 4

and click the  button. 5

> Click Next. 6

> In the next screen leave Columnar layout selected and click Next. 7

> Click Finish. 8

1

2

Why might it be helpful to use a tool to add or edit one 
record at a time instead of scrolling through a large table?
How can a simple, organized interface facilitate the entry 
of details such as name, address, and telephone number?
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4

5
3

You can change the 
name of your form.

This option opens the 
form in Form View

and lets you type data.

8

76

Alternatively, you can choose another 
layout which suits your personal taste.
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To insert records in your form:

> Simply fill in the form you have already created. 1

> When you are done, on the Home tab, in the Records group, click Save. 2

2

Create a New record 
with this button.

Use this button to go 
to the First record.

Use this button to go 
to the Last record.

This button takes you 
to the Previous record.

This button takes you 
to the Next record.

This area presents 
the Current

record.

1
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Because the StudentID field is auto-numbered, 
when you delete a record, its StudentID number is 
not replaced. If you delete the last record, e.g., No 
6, the StudentID for the next new record will be 7.

2

1

3

To delete a record:

> Navigate to the record you want to delete, e.g., the 7th 
record, and click the record selector next to the record. 1

> On the Home tab, in the Records group, click the drop-down 
arrow next to Delete, and then click Delete Record. 2

> In the warning message box, click Yes. 3

Smart Tip
To fill in a form faster, you can press  after typing each field to move to the next one. If you 
press  while working on the last field of a form, you move to the next page to insert 
another record.

In the same way, you enter data into a form, 
you can also enter data into a table. Open the 

"Students" table and type these records. 
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Personalize your forms
You can customize your form in various ways. For instance, you can add or change fields and labels.

Change the data 
source
You can also change the 
Data Source of your text 
boxes. This means that 
you can choose a specific 
field in your table, so that 
the text you type in the 
text box is saved in it.

To change the layout of your form:

> On the Home tab, in the Views group, click on the drop-down arrow and select Layout View. 1

> In Layout View, you can resize and drag all the fields and put them in the order you prefer. 2

To change the data source of a text box:

> Click a text box to select it, e.g., the text box that contains the 
name Marco. 1

> On the Form Layout Design tab, in the Tools group, click 
Property Sheet. 2

> In the Property Sheet pane, on the All tab, click the Control
Source list and click a field to link to that text box, e.g., Name. 3

> Now, whatever you write in that text box will be saved in the field 
you selected.

21

1
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3

2
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3

2

To attach a label:

> On the Form Layout Design tab, in the Controls group, click the Label button. 1

> Click anywhere inside your form. A new Label Box will be on your screen. Type "Contact 
Information". 2

> Drag the Label Box above the Contact Information data. 3

> With the Label Box selected, on the Form Layout Design tab, in the Tools group, click 
Property Sheet. 4

> In the Property Sheet pane, change Font Size to "18". 5

> Close the Property Sheet pane, 6  and save your form.

1
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6

5

 You can experiment and change some of the 
other properties and check what happens. 
The changes will be in the Layout View.

4

 It’s very important for your forms 
to be simple. Most often, people 
who work on a database mainly 
focus on the forms, because it’s 
the interface of the database.

Hands on!
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2. Read the questions and put a check mark for the correct answer.

1.  What is the purpose of a data entry form in Microsoft Access?

 a. To print the records in a table.

 b. To create an automatic backup of a table.

 c. To add, edit, or access records in a simple way.

 d. To delete all fields in a table.

2.  In the "Form Wizard," how do you include all the fields in your form?

 a. Click the ">" button.

 b. Click the ">>" button.

 c. Click the "<" button.

 d. Click the "<<" button.

1. Read the following sentences and put a check mark for True or False.

True False

1.  A "data entry form" allows users to add or edit data in a table 
without directly opening it.

2.    The "Form Wizard" allows you to choose only one field to 
display in a form.

3.  The "StudentID" field is automatically updated in a form because 
it uses the "AutoNumber" data type.

4.  The "Columnar layout" displays all the fields of a form in a 
vertical order on one page.

5.  You can use the "Property Sheet" to resize and move fields in 
"Layout View."

31
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3. Why is the "StudentID" field not included in the form by default?

 a. It is not an important field for users.

 b. It is automatically updated and does not require manual input.

 c. It is a text field and cannot be added.

 d. It can only be added through "Design View."

4.  What button would you use to ensure that changes made to a record in a form are 
stored and not lost?

 a. The "Save" button, on the "Home" tab, in the "Records" group

 b. The "More" button, on the "Home" tab, in the "Records" group

 c. The "New" button, on the "Home" tab, in the "Records" group

 d. The "Refresh All" button, on the "Home" tab, in the "Records" group

3. Forms are often called the interface of a database because they help users interact with 
the data.

Why is it important to make forms that are straightforward and user-friendly? Can you think 
of a real-life example, like an online form, and explain what makes it easy to use or 
challenging to use?
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4. Open Microsoft Access and navigate to the "Authors" table and "Books" table you created 
in the previous lesson.

1. Use the Form Wizard to create forms for the following:

 • From the "Authors" table include the fields: AuthorID and Author Name.

 • From the "Books" table include the fields: AuthorID, BookID, Title, Genre, and 
Year Published.

 • Use the Columnar Layout for both forms.

2. Once the forms are created, insert new records. More specifically:

 • On the "Authors" form, add the following data: AuthorID: Auto-generated,  
Author Name: Shel Silverstein.

 • On the "Books" form, add the following data: AuthorID: 3, BookID: Auto-generated, 
Title: The Giving Tree, Genre: Literature, Year Published: 1964.

3. Save and close the database.
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LESSON 3

Queries

How can you quickly find books by a specific author 
from a list of titles, authors, and publication years? 
Why is this helpful for organizing your reading list?

Database tables can store vast amounts of records, sometimes millions or even billions. Therefore, 
when searching for specific information, it’s necessary to filter the records and choose which ones 
to display. This is done by creating a query. A query is a request made to the database to retrieve 
particular data and obtain the information needed. For this lesson, let’s continue working with the 
"Students" table from earlier.

To create a query:

> On the Create tab, in the Queries group, click Query Design. 1

> In the Add Tables pane, click the Students table, 2  and click Add Selected Tables. 3

> Then click the Close button to close the pane. 4

> The Query Design tab will be on your screen, along with your table. Double-click the fields of 
the Students table that you want to display (Name, Class No, Telephone number, and City). 5

> The fields you selected will be on your screen at the bottom of the window. 6

> On the Query Design tab, in the Results group, click Run. 7

> The results of your query will be in Datasheet View. 8

> On the Home tab, in the Views group, click on the drop-down arrow and select Design View, 9  to 
switch back to the Query Design View. Here, you can continue to tweak your query in more ways.

1 4

3

2
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Add criteria
Now choose some of your data to display in response to your query. Let’s ask your database 
a question.

2

1

To choose some of your data:

> In Query Design View, locate the City field column and in the Criteria row, type "Dallas". 1

> On the Query Design tab, in the Results group, click Run. 2

> As you can notice from the results, 3  the query that you created ordered your database to 
select and display only the records which contained the word Dallas in the City field. 

> You can save your query at any point, preferably after you run it and check that it displays the 
desired results. To save it, right-click the query tab and click Save. 4

> Type a name, e.g., "Students from Dallas", and click OK. 5

> Your query is in the Navigation pane on the left. 6

The aim of this activity is to ask the program: 
"What are the names, classes, and telephone 
numbers of all students who live in Dallas?"
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3

4

5

Note that the quotes here are not necessary, but it’s a good practice to wrap 
any text in the Criteria row in quotes. That way, the program understands that 
you mean the word "Dallas" and not something else, e.g., a field named Dallas.

6
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Complex criteria
You can narrow down your results even more by applying more 
complex criteria to more than one field.

To apply complex criteria:

> In Query Design View, locate the Class No field column and 
on the Criteria row, type "1" Or "3". 1

> On the Query Design tab, in the Results group, click Run. 2

> Check the results. 3

The question asked here is "What are the names, 
classes, telephone numbers, and cities of all 

students who live in Dallas and are in class 1 or 3?"

2

1

3

Operators, such as "Or," 
can be used to refine query 

criteria expressions. By 
combining them, you can 

create anything from simple 
to very Complex criteria.
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Parameter queries 
Let’s say you want to create a query that will give you the contact information of a specific student. 
You can simply type the name of the student in the Criteria row of the Name field. But what if you 
had a big database with hundreds of students? It’s not practical to create a new query every time you 
want to search for a different student. In this case, you can use parameter queries.

To create a parameter query:

> In Query Design View, locate the Name field column, and in the Criteria row, type 
"[Student Name?]". 1  Clear any other Criteria, if any.

> On the Query Design tab, in the Results group, click Run. 2

> There is a message box, displaying your message and asking for a student’s 
name. 3  Type a name, e.g., "Marco", and click OK. 4

> You can use the same query and type different student names without changing 
anything or creating a new query. 5

5

1

3

2

4
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If the relationships 
in your tables need 

adjustment, you 
can delete and 

redefine them as 
necessary. You can 

even create 
relationships 

between tables 
only for a 

specific query.

Queries on tables with relationships
So far, creating queries to ask questions about a single table in the database has been covered. 
However, most databases contain multiple tables that relate to each other in specific ways. It is now 
time to learn how to create queries for such databases and ask questions about data from multiple 
tables simultaneously.

In this example, you will use all three related tables from our database: "Courses", "Grades" 
and "Students." 

Based on what you have learned so far, fill in the rest of the tables as the example below.

History
IBM started research on relational databases in 1974 and its first product was SQL/DS in 1981. 
However, Relational Software were the first to release a commercially available Relational 
Database Management System with their product Oracle in 1979.
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Now you have to create a query to find all the courses that a certain student has taken, along with 
their final grade in each course. Then, you will display the student’s name and class, the course 
name, and the final grade for all the courses that meet the specified criteria.

To create a query on multiple tables:

> On the Create tab, in the Queries group, click Query Design. 1

> In the Add Tables pane that opens, select all the tables and click Add Selected Tables. 2

> Click the Close button at the top of the pane. 3

> On the Query Design tab, double-click the fields from the tables that you want to display 
(Name, Class No, Course Name, and Final Grade). 4

> Now you will add the parameters you want. In the Name field Criteria, type "[Student Name?]". 5

> On the Query Design tab, in the Results group, click Run. 6

> A message box opens, displaying your message and asking for a student’s name! Type a 
name, e.g., "Marco", and click OK. 7

> You now have the query result, containing information on the specific student that you 
asked for. 8

2

3
1

4
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5

6

7

8
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To sort the results of your query by one field:

> Create a new query in Design View using the Students table and the fields: Class No, Name, 
Telephone number, and City. 1

> In Query Design View, locate the Class No field column and in the Sort row, click Ascending
in the drop-down list. 2

> On the Query Design tab, in the Results group, click Run. 3

> The query records are on your screen starting with the students from class 1 and ending with 
the students from class 3. 4

3

1

2

Sort
You can choose the results of a query sorted in ascending or descending order.

4
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1. Read the following sentences and put a check mark for True or False.

True False

1.  A database table can hold from 0 to billions of records.

2.  With a "Query," you can add new fields to a database.

3.  In a "Query," you can apply criteria to more than one field.

4.  "Complex criteria" allow you to use multiple conditions to filter 
data.

5.  In the "Criteria" row, you type dates in quotes only.

2. Complete with the missing word.

1.  To start creating a query, you select the  option from the 

"Create" tab.

2.  Add tables to your query using the  button in the "Add 

Tables" pane.

3.  To focus on certain records in a query, type your condition in the 

row. 

4. To get the query results, click the  button.

5. The results of the query will be displayed in "  View."
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3. Why is adding criteria in the Criteria row helpful when working with a large table? How 
does it help you find the data you need?

4.  Create a query using the "Books" and "Authors" tables to retrieve specific information.

1. Open the "LibraryInventory" database you worked on in the previous lesson.

2. Include the following fields in your query:

 • Author Name (from the Authors table)

 • Title (from the Books table)

 • Genre (from the Books table)

 • Year Published (from the Books table)

3. Apply complex criteria to your query:

 • Display only books in the Fiction genre AND published in 1943.

4.  Create a parameter query based on the "Books" table to ask the user to input a specific 
genre.

 • Use the parameter [Enter Genre:?] in the Genre field of the Criteria row.

5. Sort the results of the query in ascending order by Title.

6. Run the query, observe the results, and close the database.
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LESSON 4

Reports

Data can be entered, modified, and categorized with a database program, but to present this 
information in an easy-to-read format for others or for personal use, a report must be created. A 
database report illustrates information from a table or query in an attractive, preformatted manner.

To create a report:

> On the Create tab, in the Reports group, click Report Wizard. 1

> When the Report Wizard window opens, in the Tables/Queries drop-down list, click 
Table: Students. 2

> Move all the fields except StudentID, 3  from the Available fields to the Selected Fields. 4

> Click Next. 5

1

3

4

2

5

Why might presenting data in a report be more 
effective than displaying it directly from a table?
How can grouping and sorting data in a report 
make the information clearer to understand?
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Group the data
In the next step, you can create groups and subgroups of your data.

To add grouping:

> Move all the fields which you want to create groups from to the right. 1

> Note that the order in which you move them matters: the top field has 
priority over the ones that follow. 2

> Click Next. 3

1
2

These arrows change 
the priority of the group.

3

Sort the data
In the next step, you can add more 
fields to sort and define their sort order.

To add sorting:

> Click a field from the first 
drop-down list, e.g., Address. 1

> Click Next. 2

2

1

You can change the sort order from Ascending
to Descending by clicking the button next to 

the list. You can add up to four fields.

Grouping allows you to 
concentrate all related data, 

e.g., all the data for one person. 
This way, on one page are all 
the data for a specific person.
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Set the layout
In the next step, you can select how your report will appear on the screen.

To set the layout:

> Under Layout, click Outline. 1

You can experiment with the 
other layouts later if you want.

> Click Next. 2 1

2

Name the report
In the final step, you can name your report.

To give your report a name:

> Type a name for your report in 
the text box, e.g., "Student 
Report". 1

> Click Finish. 2

1

2

Your first report is ready. You 
have grouped your data by 

Class No and then by Name.
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To edit a report:

> Right-click the Student Report in the Navigation pane. 1

> Click Layout View. 2

> In this window, your data is presented as it is displayed when you open the report. 
You can delete anything unnecessary.

> For example, delete the Name label, 3  and change the position of the Name text 
box. 4

> Click the text boxes that are more important, e.g., the Class No text box, and on the 
Home tab, in the Text Formatting group, make them bold using the Bold button. 5

> Your report is now ready. 6

1

2

3
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6

5

You can also change position, 
font size and alignment as 

well as any of the other 
known text formatting options 

for all text boxes and labels.

Grouping and sorting
You may want more control of the 
grouping and sorting options for your 
report than the Report Wizard
can provide.

To change the grouping and sorting options:

> On the Report Layout Design tab, in the Grouping & 
Totals group, click Group & Sort. 1

> You can find the Group, Sort, and Total pane at the 
bottom of the screen. 2

1

2

Here, you can 
delete or 

rearrange the 
order of your 

groups and sorts.

You can also add a 
group or add a sort.

Here, you can edit the sorting 
order of your groups and sorts.

4
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To create a report with totals:

> On the Create tab, in the Reports group, click Report Wizard. 1

> In the Report Wizard window, in the Tables/Queries list, select Name, Class No, Course
Name, and Final Grade from the relevant tables and click Next. 2

> In the next step, click by Students and click Next. 3

> In the next steps, group by Class No, 4  and sort by Course Name. 5

> Under Layout, click Outline and then click Next. 6

> Finally, name your report, e.g., "Student Final Grades" and click Finish. 7

> As a result, you have a report with the final grades of all students in all their courses. 8

1

3

4

Totals
Sometimes in your reports, it is useful to include calculations in your data that are calculated every 
time someone views the report. Let’s explore how you can calculate and display the average final 
grade of each student in a report.

2
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8

6

5

Τo add totals:

> Open the Student Final Grades report in 
Layout View. 1

> Click a Final Grade box. 2

> On the Report Layout Design tab, in the 
Grouping & Totals group, click Totals, 3

and then click Average. 4

> You can find a new text box, containing the 
average grade from each class group. 5

> Finally, an average for all students of all 
classes is presented at the end of the 
report. 6 1

7
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5

Right-click on the number 
and select Set caption to 
add a label, explaining the 
new field on your report.

4

3

6

53For Review Purposes Only 



1.
 H

an
d

li
n

g
 d

at
ab

as
es

2. Complete with the missing word.

1.  To start creating a report, you select the  option from the 

"Create" tab.

2.  Adding  in reports helps organize data by categories, such as 

Class No or City.

3.  To edit the design of a report after it is created, use the 

option. 

4.  To calculate and display the average grade of students in a report, use the 

 option.

5.  After designing and naming your report, click the  button to 

save and view it.

1. Read the following sentences and put a check mark for True or False

True False

1.  A report is used to present information in a clear and readable 
format.

2.  In a report, you can change the position of the field names, 
the title, and the record fields.

3.  You cannot change the sorting order in a report.

4.  In a report, you can add a group, sort data, and rearrange the 
order of groups and sorts.

5.  If you apply totals to a report with one group, three types of 
text boxes will be displayed.
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3. Why is it important to group information in a report and include calculations like averages 
or sums? How do these features make the report clearer to understand and more useful?

4. Create a report using the "Books" and "Authors" tables to display grouped information.

1.  Open the "LibraryInventory" database you worked on in the previous lesson. 

2. Include the following fields in your report:

 • Author Name (from the Authors table)

 • Title (from the Books table)

 • Genre (from the Books table)

3. Ensure the report groups the data by Genre.

4. Sort the data in the report by Title in ascending order.

5. Name the report "BooksReport."

6. Customize the layout of the report:

 • Use Bold text for Genre and Author Name.

 • Display a summary at the end of the report that counts the total number of books.

7. Change to Report View, to verify the output, and close the report.

8. Close the database.
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LESSON 5

Import and export data

Importing and exporting data are important features for any software, especially databases. These 
functions allow data to be transferred between different programs for further use. For example, you 
can export data from a database to a spreadsheet for analysis, or take an old database stored in a 
spreadsheet and move it into a more powerful database program to simplify updates and 
maintenance.

To export data to Microsoft Excel:

> In the Navigation pane, click the object you want to export data from, e.g., the Students table. 1

You can export data from any table, query, form, and report objects.
> On the External Data tab, in the Export group, click Excel. 2

> In the Export - Excel Spreadsheet window, specify the destination file name and format for 
your Microsoft Excel file, e.g., "Students.xlsx". 3

> Click OK. 4

> Click Close on the next window. 5

> Your data has been exported to Microsoft Excel. 6

1

2

Why is it useful to be able to export data from 
a database to a program like Microsoft Excel?
When might importing data into a database 
save time compared to entering it manually?
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4

3

Select another 
location for your file.

With this option, you can preserve most of your formatting.

 Automatically opens the 
final file for your results.

Select and export specific records from your table.

Save the steps you want 
to repeat every time.
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1

To export data to a text file using Comma Separated Values (CSV):

> In the Navigation pane, click an object which you want to extract data from, e.g., the 
Students table. 1

> On the External Data tab, in the Export group, click Text File. 2

> In the Export - Text File window, type a file name for your text file, e.g., "Students.txt," 3

and click OK. 4

> In the next window, leave Delimited selected and click Next. 5

> In the next window, click Include Field Names on First Row, 6  and then click Next. 7

> In the next window, change the name of the file if you want and then click Finish. 8

> In the next window, click Close. 9

Browse to select another 
location for your file.

4

3

With this option, 
you can preserve 

most of your 
formatting.

2
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Are these steps familiar to 
you? Remember when you 
exported a CSV file from 
Microsoft Excel? These 
steps are very similar.

5

7

6

8

9
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To import data from a Microsoft Excel file:

> Open Microsoft Access and create a new blank database.
> On the External Data tab, in the Import & Link group, click New Data Source. 1

> In the menu that opens, click From File and click Excel. 2

> In the Get External Data - Excel Spreadsheet window, click Browse to select 
the Microsoft Excel file you want to import, e.g., "Students.xlsx," and 
click OK. 3

> Click Next. 4

> In the next window, make sure First Row Contains Column Headings is 
checked if you have a header row in the Microsoft Excel file you are importing, 
and then click Next. 5

> Click each displayed field and make sure the Data Type is correct. If not, change 
it to the correct value. Then, click Next. 6

> In the next window, if your data from Microsoft Excel contains a field that is or 
can be used as a primary key in your database, click Choose my own primary 
key and click the appropriate field in the drop-down list, e.g., "StudentID." 7

Then, click Next.
> Finally, in the Import to Table box, type a name for the table that is going to be 

filled with your data, e.g., "Students". Then, click Finish. 8

> In the next window, click Close. 9

2

1
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6

3

Create a new table with all the imported data.

Make a table that it is connected to Microsoft Excel. Every change that you 
make to Microsoft Excel will be applied to Microsoft Access but not vice versa. 

5
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Smart Tip
Most of the time, the only thing you have to do when a wizard pops up is to click "Next" until you 
finish all the steps. Although it’s fully automated, check at each screen to make sure that the 
preselected options are the ones you want.

Check this and 
you won’t have a 

Primary Key field. 

7

Click this and 
Microsoft Access will 
decide which field is 

the Primary Key field.

8

9
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To import data from a CSV text file:

> Open Microsoft Access and create a new blank database.
> On the External Data tab, in the Import & Link group, click New Data Source. 1

> In the menu that opens, click From File and click Text File. 2

> In the Get External Data - Text File window, click Browse, 3  to select the text file you want to 
import, and click OK. 4

> Click Next. 5

> In the next window, make sure First Row Contains Field Names is checked, 6  if you have a 
header row in the CSV file you are importing, and then click Next. 7

> The remaining steps are exactly the same as in the previous example when you imported data 
from a Microsoft Excel file. 

3

4

1

2
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75

6

To import database objects like tables, queries, forms, and reports from another Microsoft 
Access database file:

> Open Microsoft Access and create a new blank database.
> On the External Data tab, in the Import & Link group, click New Data Source. 1

> In the menu that opens, click From Database option and click Access. 2

> In the Get External Data - Access Database window, click Browse, 3  to select the Microsoft 
Access database file from which you want to import objects, e.g., "Database.accdb."

> Click OK. 4

> In the Import Objects window, select the objects you want to import, e.g., the Courses and 
Students tables, 5  and then click OK. 6

> Click Close, 7  and your objects will be waiting for you in the Navigation pane.

1

2
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5

7

You can import a specific 
item from a database or 

import the entire database.
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2. Read the questions and put a check mark for the correct answer.

1. What does selecting "Delimited" during export mean?

 a. Data is separated by spaces.

 b. Data is separated by characters like commas or tabs.

 c. Data is grouped by rows.

 d. Data is exported without separators.

2.  When exporting data to Microsoft Excel, which feature ensures you save time in future 
operations?

 a. Select "Include Formatting."

 b.  Save Export Steps.

 c.  Use the "Navigation Pane."

 d. Export only selected records.

1. Read each of the statements carefully and check True or False. 

True False

1.  You can export data from a table in Microsoft Access directly to 
Microsoft Excel.

2.   When exporting data to a text file, the format options include 
both "Delimited" and "Fixed Width."

3.  The "First Row Contains Field Names" option must be checked 
while importing data to set column headers correctly.

4.  Linking a Microsoft Excel file to Microsoft Access allows you to 
edit the source data in Access.

5.  You can save your export steps to repeat the process efficiently 
in the future.
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3.  What should you do when importing data from a CSV file into Microsoft Access?

 a. Choose "Link Table" for automatic synchronization.

 b. Select "Delimited" and ensure the first row has field names.

 c. Use the "File Properties" option to edit the table structure.

 d. Ensure that "Primary Key" is unchecked.

4.  Which field is typically used as a "Primary Key" when importing data into Microsoft 
Access?

 a. A field with unique values for each record

 b.  A field with multiple duplicates

 c. A field with all text values

 d. A field left blank in the source data

5. How do you ensure data formatting is preserved when exporting to Microsoft Excel?

 a. Select "Open File after Export."

 b.  Choose "Export Data with Formatting and Layout."

 c. Save the export as a text file instead.

 d. Click "New Data Source" and export.

3. Complete with the missing word.

1.  To export a table from Microsoft Access to a spreadsheet, choose 

 as the format.

2. A  file uses characters like commas to separate data.

3.  When importing data, always define a  to ensure unique 

identification for each record. 

4. Use  to repeat export operations with the same settings.

5.  When you  data, ensure the first row contains field names to 

maintain consistency.
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Plan an Event Database

4. Why is it important to export data to formats like Excel or CSV when sharing information 
with others? How does exporting data in these formats make it more efficient for teams to 
analyze and collaborate?

5. Export the report in the default folder to a Microsoft Excel file named "Books.xlsx."

1. Open the database you created in the previous lesson and the report "BooksReport."

2. Ensure:

 • Data formatting and layout are preserved.

 • The file automatically opens after the export.

3. Export the "Books" table as a CSV file:

 • Name the file "BooksExport.csv."

 • Ensure field names and data formatting are preserved.

4. Save and close the database.
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Project
Plan an Event Database

1. Create three tables.
• The "Events" table will include information about the events being organized. 

• The "Attendees" table will store details about the people attending the events. 

• The "Tasks" table will track the tasks associated with each event, including deadlines and 
statuses.

• You can use the following fields in your tables:

• Don’t forget to set "Primary Keys" for your tables.

• After you create the tables above, connect them using relationships. Each event can have 
multiple attendees and tasks, as illustrated in the relationship diagram below.

Create a database in Microsoft Access to track event details. This database will track 
event details, attendees, and tasks. 
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2.  Use the Form Wizard to create one data entry form for each table. Use the forms 
to input sample data into your database.
 • For the "Attendees" table, use your classmates’ personal details.

 • For the "Events" table, add sample events, such as "Science Fair" or "Cultural Fest."

 • For the "Tasks" table, list tasks like "Decorations" or "Prepare Invites", including deadlines and 
statuses such as "In Progress" or "Completed."

3. Create a report using the Report Wizard.
 • Use the fields EventID, EventName, Name, Email, Description, and Deadline from the available 

tables. 

 • Group the report by EventID. 

 • Sort the report by EventName in ascending order and set the Layout to Outline and the 
Orientation to Landscape. 

 • Name the report "EventsReport."

4. Create and run the following queries.
 • Find all attendees for a specific event based on "EventName" input.

 • Display all tasks that are marked as "In Progress" and their deadlines.

5. Export and import data.
 • Export the "Tasks" table to a Microsoft Excel file named "TasksList.xlsx." Ensure data formatting 

and layout are preserved.

 • Modify the Microsoft Excel file by adding a new column named "AssignedTo" and fill it with 
team member names.

 • Import the modified Microsoft Excel file back into Microsoft Access as a new table named 
"UpdatedTasks."

 • Ensure the First Row Contains Field Names option is selected during the import process.

 • Save and close the database.
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1. What did you learn about organizing data in a database that you didn’t know before?

2. How did creating relationships between tables help you understand the connection 
between different types of data?

3. What was the most challenging part of designing and managing the database for the 
project? How did you overcome this challenge?

4. How did your team collaborate to input data and create forms and reports? Was everyone 
able to contribute effectively?

Reflect
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HanDBase for iOS
With HanDBase you can track 
almost anything on an iPhone or 
iPad. Here, you can have a 
shopping list, music and DVD 
collections, project organizers, 
sports schedules, or that list of 
passwords you keep handy in 
the desk drawer.

Memento 
for Google Android
Use Memento to gather all the 
information about DVD collection 
or books. Categorize your 
database by Director or Author 
and extract any information that 
you want. Find out how many 
books you have by a certain 
author or how many movies with 
your favorite actor. 

Obvibase and Caspio 
If you want to keep everything 
organized and readily accessible, 
you can use online database 
creators like Obvibase and 
Caspio. Now you can access 
your data from any web browser, 
and your data is secure and 
manageable.

Take a moment to reflect on your progress.
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Take a moment to reflect on your progress.

Wrap up
How confident are you in your ability to apply the following skills?
> I can explain what structured information is and describe its importance.
> I can create a database, add tables, and input data in Microsoft Access.
> I can describe different data types and their uses in a database.
> I can create and customize data entry forms using the Form Wizard.
> I can create and run queries to retrieve specific data and use parameter queries.
> I can create, customize, and save reports, including adding fields and calculations.
> I can export data from a database to Microsoft Excel and CSV files.
> I can import data from Microsoft Excel and CSV files into a database.

Key Terms
criteria

database

data source

data type

export

field

field property

group

import 

label

parameter

primary key

query

relationship

report

structured information
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